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1 License Agreement

BY INSTALLING AND USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF
THIS AGREEMENT. IF YOU DO NOT AGREE TO THE TERMS OF THE AGREEMENT, PLEASE
REMOVE THE SOFTWARE.

SOFTWARE LICENSE AGREEMENT

Use of XmediaStorm  (hereinafter "SOFTWARE") is contingent on your agreement to the following
terms:

GRANT OF LICENSE
XmediaStudio (hereinafter "XMEDIASTUDIO") grants you a limited, non-exclusive license to use the
SOFTWARE.
The SOFTWARE is licensed, not sold, to you for use only under the terms of this Agreement.

Shareware Version Evaluation and Registration

Subject to the terms below, you are hereby licensed to use this SOFTWARE for evaluation purposes
without charge for a period of fifteen (30) days. If you use this SOFTWARE after the 30-day evaluation
period a registration fee is required. If you happen to go over your fifteen(30) day evaluation period
without realizing it, the SOFTWARE will remain functional as a convenience to those of you who must
get critical work done before you have a chance to purchase a license. The registration fee grants you
the right to use this SOFTWARE for unlimited time. When payment is received you will be sent your
own personal registration code.

Registered Version
One registered copy of SOFTWARE may either be used by a single person who uses the SOFTWARE
personally on one or more computers, or installed on a single workstation used non-simultaneously by
multiple people, but not both. You may access the registered version of SOFTWARE through a
network, provided that you have obtained individual licenses for the SOFTWARE covering all
workstations that will access the SOFTWARE through the network.

SCOPE OF GRANT
You may not decompile, disassemble or otherwise reverse engineer the SOFTWARE, or engage in
any other activities to obtain underlying information that is not visible to the user in connection with
normal use of the SOFTWARE. You may not modify, rent, or resell for profit this SOFTWARE, or
create derivative works based upon this SOFTWARE. You may not publicize or distribute any
registration code algorithms, information, or registration codes used by this SOFTWARE without
permission from XMEDIASTUDIO.

In no event shall XMEDIASTUDIO's liability exceed the purchase price of the SOFTWARE.

COPYRIGHT
This SOFTWARE is protected by copyright laws and international copyright treaties, as well as other
intellectual property laws and treaties.

DISTRIBUTION
Only the shareware version of this SOFTWARE may be freely distributed.

Provided that you verify that you are distributing the shareware version, you may distribute this
SOFTWARE on on-line services, bulletin boards, or other electronic media provided that it is not
modified and the original archive remains intact with all accompanying files, and provided that no fee is
charged. This SOFTWARE may not be distributed on CD-ROM, disk, or other physical media for a fee
without the permission of the XMEDIASTUDIO.
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TERMINATION
The license will terminate automatically and the SOFTWARE unregistered if you fail to comply with any
of the above terms and conditions. The license may be terminated by either party at any time and
without notice.

DISCLAIMER OF WARRANTY
THIS SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND. TO THE
MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, XMEDIASTUDIO FURTHER DISCLAIMS
ALL WARRANTIES, INCLUDING WITHOUT LIMITATION ANY IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND NON INFRINGEMENT. THE
ENTIRE RISK ARISING OUT OF THE USE OR PERFORMANCE OF THE PRODUCT AND
DOCUMENTATION REMAINS WITH RECIPIENT. TO THE MAXIMUM EXTENT PERMITTED BY
APPLICABLE LAW, IN NO EVENT SHALL XMEDIASTUDIO BE LIABLE FOR ANY
CONSEQUENTIAL, INCIDENTAL, DIRECT, INDIRECT, SPECIAL, PUNITIVE, OR OTHER
DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF
BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR
OTHER PECUNIARY LOSS) ARISING OUT OF THIS AGREEMENT OR THE USE OF OR INABILITY
TO USE THE PRODUCT, EVEN IF THE XMEDIASTUDIO HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.
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2 How to Register

How to order
To register XmediaStorm, you need to purchase license(s) from XmediaStudio. All
XmediaStudio products can be ordered online securely at: http://order.XmediaStudio.com.
Your registration code will be emailed in 48 hours once the order is confirmed.

How to activate XmediaStorm
Instructions on how to activate XmediaStorm will be sent together with the registration code.
Once you get the code, activation of the program is easy and instant.

http://order.XmediaStudio.com
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3 Introduction

Capture, view, broadcast (web streaming), edit, organize, share your videos and digital
photos easily with XmediaStorm. If you own a digital camera, a digital camcorder, have a
large collections of pictures and videos, or you just like to record your favorite TV programs,
you may need XmediaStorm, a software designed to make your digital life hassle free. More
information is available online at XmediaStudio web site.

What can XmediaStorm do?

Capture and organize videos. Capture video from DVC (Digital Video camcorder), TV
tuner card, VCR, webcam, or any other compatible analog/digital video source.

Capture, edit and organize pictures. Import/scan pictures from digital camera, scanner, or
other TWAIN compatible device. Touch up pictures with built-in picture editor.

Broadcast (web streaming) your videos online! Broadcast your videos directly over internet
or intranet in WM9 format! Or, with built-in xTransporter, send pictures and videos through
email,FTP.

Find pictures and videos quickly. Search all videos and pictures according to name,
description, date, time, category etc.. .

Present your pictures and videos with various slide transition effects. Impress your friends
with full screen dual monitor output.

Manage your DV tapes or other removable media. If you have too many DV tapes, don't
waste your time and hard disk to convert them all. Let XmediaStorm manage them for you. With
a mouse click system will tell you which tape you need to insert and start playing from the point
you marked! Find out more here..

http://www.XmediaStudio.com
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4 Getting Started

4.1 User Interface

XmediaStorm has a straight forward user interface. To know the function of a button, input
box or any other visual items, you can simply move mouse over and a hint will pop out. The
main user interface is divided into three panels:

·Display panel
·Control panel
·Item list panel

To switch between modules you need to use buttons described below:

Button 1: Video - Click to switch to Video mode

Button 2: Image - Click to switch to Image mode

Button 3: Scheduler - To call out schedule tools

Button 4: System Setting - To configure your system

Button 5: Close application
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4.2 Control Keys

GENERAL:
CTRL+A : Select all items under current category
CTRL+U : Unselect all items under current category

PICTURE MODE: To use hot keys, click on the picture or list window to set focus on it:
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 KEY STROKE FUNCTION

+ Zoom in picture

- Zoom out picture

\ Fit picture into current display window

/ Display picture in original size

F11 Show picture using full screen (ON/OFF)

ESC Quit full screen mode

PgUp Display previous picture in the list

PgDn Display next picture in the list

END Display last picture in the list

HOME Display first picture in the list

MOUSE CLICK FUNCTION

Double click on picture (mouse) Switch between "separate window" and
"integrated window" mode

VIDEO MODE: To use hot keys, click on the video window or list window to set focus on it:

MOUSE CLICK FUNCTION

Single Left Click on the video Zoom into video and make current point
screen center

Single Right Click on the video Zoom out video and make current point
screen center

Double Click on the video Switch between "separate window" and
"integrated window" mode

Single click on the list item's thumbnail picture Display item information

Double click on the list item's thumbnail picture Play the video

4.3 Video Manager

As one of the three core modules of XmediaStorm, the video manager takes care of video
capturing, playing back, broadcasting and video management. In order to capture video, it
requires a video capture device like capture card, TV tuner card or a IEEE1394 (firewire
port). If you don't have any capturing device installed, then you can only use it as a video
player to playback the existing video files or a web streaming server to broadcast existing
video on the hard disk.

Features:

· Support most video capture cards, TV tuner card, DV Camera, webcam and VCR.
Support IEEE1394 (iLink, Firewire) connection.

· Support most video formats like uncompressed AVI, WM9, MPEG4, ASF, WMV
etc...

· Able to Record and encode directly to WM9 or MPEG4 format (need WM9 runtime



Getting Started 14

Copyright (c) 2002-2004 XmediaStudio

and MPEG4 codec).
· Play back the video file while recording is still in progress (when record to WM9

format only).
· Scheduled recording of video and TV programs.
· Superimpose text and timestamp to video on the fly. Flexible text style.
· Record video on motion detect. user selectable motion detect sensitivity.
· Built-in channel manager for TV tuner cards. Auto tune and select channels using

built-in TV control panel.
· Control DV cameras to play, pause, record, fast forward, rewind, step forward and

time code searching from the software's built-in DV control panel.
· Import and index existing video files from local or network drives into video

library.
· Capture still frames from video to clip board or to own video library.
· Powerful video player with full screen playback. Play back full screen video on

second monitor if dual monitor card is installed.
· Play back only the 'favorite' part of video without tampering the whole footage.
· Launch your favorite third party video editor from XmediaStorm to edit selected

video.
· Convert video files to different formats.

· Store meta data (ie, story written for the video) together with video.

The video control panel consists of three sub-panels: Video recorder panel, video player
panel and TV control panel. The TV control panel is hidden behind video player and can be
called out by clicking button 'TV'. Below are screenshots of panels and description for each
button function.
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ITEM DESCRIPTION

Record start date and time

Current time code (if connected to a VCR)

Recorded video length

Current video size and last captured screen preview
(recorder)

Highlight to indicate 'Schedule' is active

Highlight to indicate motion detected

Highlight to indicate "Webcast" is in progress

Connect/Disconnect from video source

Start recording

Pause recording

Change recording settings

Show/Hide TV control panel

Capture a video frame and save to the inbox of picture
library

Capture a video frame to clipboard. You can paste the
captured frame to other applications.

DVC control panel. It will be enabled only if you have a
DVC/VCR connected.

 Play the video tape               Record (on tape)

 Step back by one frame        Record single
frame

 Step forward by one frame     Pause record

 Stop                                    Mark in current tape
time code

 Rewind                                Mark out current tape
time code

 Fast Forward                   Add marked section to
video library

 Capture marked section to hard disk and add into
video library

 Find and roll tape to specified
position (Time code). The time code format is
HH:MM:SS:FF, where HH is the hour, MM is the
minute, SS is the second and FF is the frame number.
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Start/Stop broadcasting (web streaming). By default,
the program will broadcast to port 7070. You can
always change it in system preference pages. To
watch your video from another computer, simply open
Windows Media 9 or newer and choose "Open URL"
and then enter "http://ComputerName:port"
The length of the media loaded in player

Current position of the media being played

'Mark in' preview

'Mark Out' preview

Last captured frame preview (Player. No picture
available)

Highlight to indicate dual monitor mode

Highlight to indicate repeat current video forever

Highlight to indicate 'Scheduler' is active

Play selected video. If the otem is a VCR tape, it will
automatically find the marked in position and stop
playing at marked position.item
Stop current video playback

Pause current video

Repeat playing current video clip

Mute audio
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Zoom in video

Zoom out video

Zoom to window width

Restore original video size

Play current video in full screen mode

Step back by one frame

Step forward by one frame

Mark in current position

Mark out current position

Add marked section to favorite list. When double click
to play the favorite item, it will start playing from
marked in position and stop at mark out position.
Update library item's preview picture with current video
frame

Set current channel to the number specified

Search backward / forward for next available TV
channel
Save current channel to the list

Automatically search for available channels

Setup TV tuner card

Choose the country you are in. System will choose a
TV format automatically according to country.

Choose TV signal format (automatically selected
according to country)

Choose a TV input source

Edit channel name here

Channel item. Click to set channel.
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ITEM DESCRIPTION

Show/Hide category window

Show/Hide search window

Show/Don't show content of all sub-categories.

Select all items under current category

Unselect all items under current category

List view. Show item thumbnail only

Detail view. Show item thumbnail together with other information

Import existing video files to library

Export video from library

Delete selected items

Send/Share selected items through FTP or email.

4.4 Picture Manager

The picture manager manages all still pictures on hard disk or removable media. It captures,
store, index and present digital pictures according to your preference.

· Capture or import pictures from digital camera, scanner, video clips or other
compatible TWAIN sources. You can also capture video frames from incoming
video source or local video file.

· Support most picture formats like: JPG, BMP, TGA, ICO, EMF, GIF, PNG, WMF
etc...

· Read digital photo's EXIF information.

· Transform pictures between different formats and size.

· Auto slide show selected pictures with various transition effects.

· Full screen display and support dual monitor output. Have one monitor display the
control screen and picture thumbnails and the other output the full screen picture!

· Touch up pictures with built-in simple editor and effect generator. You can zoom,
rotate, mirror, flip, crop pictures. you can also add special effects by applying
more than 20 ready made filters.

· Store meta data (ie, picture description) together with the picture.
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XmediaStorm is able to extract digital photo EXIF information. Below is the screentshot of
EXIF window:
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ITEM DESCRIPTION

Rectangular selection

Lasso selection

Magic selection

Zoom in/out. Move cursor on top of image and left click to zoom in, right click to zoom
out.

Move image

Enable/Disable alpha channel (if any)

Call out special image effect window for image processing

Call out color effect window for image processing

Auto fit image into screen

Crop image

Mirror image horizontally

Mirror image vertically

Rotate image to the right by 90 degree

Rotate image to the left by 90 degree

Rotate image by degrees as specified by user.

Undo last change

Slide show of selected images. You can specify transition effects using effect list box.
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ITEM DESCRIPTION

Show/Hide category window

Show/Hide search window

Show/Don't show content of all sub-categories.

Select all items under current category

Unselect all items under current category

List view. Show item thumbnail only

Detail view. Show item thumbnail together with other information

Import images to library

Export images from library

Print current picture

Capture images from TWAIN devices like scanner.

Delete selected items

Send/Share selected items through FTP or email.

4.5 Scheduler

Scheduler is a robot which will run predefined jobs automatically at specified date and time.
Currently you can add following tasks to scheduler:

· Video recording - record video and audio from specified ports
· TV recording - record TV programs from specified channel at specified time

· Stop recording - stop whatever recording in progress

By default, the scheduler is disabled. To enable just click the 'START' button.
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ITEM DESCRIPTION

Start date of scheduled events

Start time of scheduled events

Task list

The DATE field will be ignored when
checked. The task will run everyday at
specified time

Add or remove the scheduled task. To
remove a task from schedule, first
select the task then click 'Remove'
button

Show only unfinished tasks

Start/Stop scheduler.

Task status (DONE, PENDING...).

Specify the video and audio input to
capture from. If you are recording TV
programs, you need to specify a
channel number as well.
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4.6 Favorites

Favorites are a list of logical
items added by user. They are
links to a certain part of the
'real' video. You can select
multiple favorite and play them
one after another like a single
file. You can also search your
favorites according to
descriptions.

If you delete the linked video
file, your favorite item will
expire also. You will be
prompted to delete it when
trying to play an expired
favorite item.

To create your own favorite
item, please refer to
Adding Part of Video to Favori
tes

4.7 Sender

Sender is a utility that can upload your picture and video to remote FTP server or send them
by email. With sender, you are able to:

· Send selected picture and video to unlimited number of peoples listed in the email
list
· Upload picture and video to unlimited number of FTP servers in the list
· Automatically generate the URL of files uploaded to FTP server and email using
predefined templates.
· Build an email list for frequently used emails
· Build a FTP list for frequently used FTP servers

To select video and picture to send, please click the check box at top right corner of item.

After you selected all items, click  and the Sender will be launched automatically.



XmediaStorm User Manual & Tutorial25

Copyright (c) 2002-2004 XmediaStudio



Part

V



XmediaStorm User Manual & Tutorial27

Copyright (c) 2002-2004 XmediaStudio

5 Working with XmediaStorm

5.1 Configuration - General

When first time start XmediaStorm, you will be prompted to setup the program. By default
the program will create following folders for you:

·  DATA folder: where your system databases are located. You can change it to other location. But
you need to copy all the files over.
·  VIDEO folder: All recorded video and imported video files will be saved here.
·  IMAGE folder: All captured images and imported images will be saved here.

There are two setup pages in XmediaStorm: General setting page and AV setting page.
General setting controls XmediaStorm overall behaviors like where to store captured video
and pictures, which mail server to use to send pictures and which user interface to use. AV
setting contains all audio and video settings for capture device, input port, codecs and other
settings.

General Setting
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INTERNET
An outgoing mail server is
required when you send
picture or video by email. The
server, user name and
password are same as the one
you use in email programs. If
you are using Microsoft
Outlook, you can easily find
those settings in menu 'Tools-
>Email Accounts'.

WEBCAST
You can broadcast video over
network in WM9 format.
Viewers need to install the
free Microsoft Windows Media
9 player.
Broadcast at port: Select the
port you want to broadcast to
Max connections: Specify the
maximum number of users
can connect to your
computer.
WM Profile to use: Choose a
Windows Media profile to use.
The profile you choose
decides the size and quality of
streamed video(The video
viewers can watch).
Save to File: Check this box if
you want to save a local copy
of broadcasting file. make
sure you have enough hard
disk space.
How to watch the video over
network:
Open Windows Media Player 9
on any networked computer
and select menu 'File->Open
URL'. In the pop out window,
input your current computer
name followed by the port
number. For example,
http://DadComputer:8080.

DATA FOLDERS
Here you tell where
XmediaStorm should store
user data, picture and video.
You can change it anytime
you like. When you change
the folders, all existing data,
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5.2 Configuration - Audio & Video

Audio and video settings can be accessed anytime before or after recording (not during

recording). You can call out AV setting page using button  located on video recorder
panel.

AV Setting



Working with XmediaStorm 30

Copyright (c) 2002-2004 XmediaStudio

DEVICE SETTING
Video Device: Video capture
device. For example, a TV
tuner card, Digital Video
Camera. There is no
compatible device detected if
the list is empty.
Video Input No: For
multiple-input capture card,
you need to specify which
input to capture from.(S-
Video, composite  etc..).
TV Input No: Select the port
number for TV tuner if you
have a tuner card installed.
You can call out the tuner
dialog by clicking the 'Tuner'
button.
Audio Device: Select an
audio capture card(ie, sound
card)  to use .
Audio Input No.: Specify the
port to capture audio from.
For most sound cards, you
need to specify whether you
capture from line in,
microphone or CD in.

CAPTURE SETTING
WM Profile: If 'Record to
Windows Media 9 format' is
selected, you need to specify
a profile to use. A profile is a
set of parameters decide the
size and quality of WM9

video. You can click on  to
import your own profile. The
free Microsoft Windows Media
9 Encoder can be used to
create a customized profile.
Video Codec: Codec used to
compress video. Select
'Uncompressed' for best video
quality (larger file).
Audio Codec: Codec used to
compress audio. Select
'Uncompressed' for best audio
quality (larger file).
Audio Delay: Set to a
negative value if audio lags
behind video. Set to a
positive value if video lags
behind audio.
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5.3 Working with Video

5.3.1 Recording Video

Step by step instructions on capturing video.
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STEP 1
Before you start, please
setup XmediaStorm first. You
can do this by click the
button circled by red line.

STEP 2
In the 'AV Settings' page,
choose the right capturing
device and input port number
from the list box.

STEP 3
Choose the video format. If
you choose WM9, you need
to select a WM9 profile also.
The quality of captured video
is decided by the profile you
choose. You need to specify
the video and audio codec to
use if you uncheck 'Record to
Windows Media 9 format'. If
you are not sure which codec
to use, just select
'Uncompressed' for both. You
only need to do Step1,2,3
once and all settings will be
saved.

STEP 4
Click the 'Connect' button to
connect capturing device
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5.3.2 Managing DV Tapes

Step by step instructions on using XmediaStorm to manage your DV tapes without
converting them.
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STEP 1
Insert DV tape into DV
camera. Turn on DV camera
and set to 'Play' mode.
Connect DV camera to
computer through IEEE1394
(Firewire, iLink) port.

STEP 2
If the DV camera is
connected successfully, the
DV control panel will be
enabled. You can control your
DV camera to play, rewind,
search, pause, frame step
using XmediaStorm DV
control function buttons.

Click 'Play'  button and you
will see the camera start
playing tape and the video
will appear on XmediaStorm
preview window and current
time code will be displayed.

STEP 3
When playing tape, click

'Mark in'  button  at the
picture you think best
describe the content of the
tape. The picture will be
displayed in the LED panel
indicating a successful mark
in. To know the time code of
current mark in position, just
move mouse over mark in
button and wait until the hint
message pop up. You will see
a message similar to 'Mark in
[23:03:12]'.
To mark out, just repeat the
same step as mark in and

click  . If you already know
the time code of the position
you are looking for, just key

in the code and click 
button. XmediaStorm will
search the tape and pause at
the position you specify. You
will see a icon  appear on
the LED panel next to the
time code when searching is
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5.3.3 Using TV tuner card

XmediaStorm has built-in TV channel manager. If you have TV tuner card installed, clicking
'TV' button will bring out TV control panel. When first time using TV tuner card, you need to

setup tuner card. Click on  to bring out setup page.

    

STEP 1: Setup tuner card
To setup TV tuner card, you need to specify the country TV source (Antenna or cable?). Once you
have chosen country, the TV format will be automatically assigned. If you think the format is not
correct, you can manually change it. Click 'Setup' button again save and exit current page.

STEP 2: Channel tuning

Click  to search for available channels. To do a manual searching:

(a) Enter starting channel number and press enter. 

(b) Click  to do a forward searching or  for backward searching

(c) Click  to save new channel into channel list.

To delete a channel from list, select the channel and press 'Delete' key on keyboard.
To rename a channel, click to select the channel, edit the name and click 'Update' button.

5.3.4 Broadcasting Video over network

You can broadcast (web streaming) video over internet or intranet in Windows Media 9
format. Any networked computer with Microsoft Windows Media Player 9 can watch the
streamed video online.

Setup XmediaStorm for broadcasting
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Setup

Select a port to broadcast to
and the maximum number of
viewers allowed.
Choose a Windows Media
profile. A better video quality
requires more bandwidth. So
select a suitable profile
according to your connection
speed.
You may want to save a local
copy of broadcasting file.
Simply check the box and
choose a location to store the
file.

Connect

If you are broadcasting from
a video source like camera,

capture card, click  to
connect the device. If you
want to broadcast TV
programs, you need to switch

to TV panel by clicking 

Broadcast

Click  to start
broadcasting. The icon

 appears on the LED
panel indicating the web
streaming is in progress.

Watch video from client computer
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Start Windows Media
Player 9

Start Windows Media Player
and select menu 'File->Open
URL'

Open URL

Input your XmediaStorm
computer's name or IP
address followed by port
number. You can also input
the computer name instead
of IP address.

To find out your
XmediaStorm computer's IP
address, type 'ipconfig' in
command mode.

DONE

Click 'OK' and you will see
'Connecting to media ...'
appears in the status bar of
Media Player. If the video
didn't come out, please check
whether your IP and port
number are correct.

5.3.5 Adding Part of Video to Favorites

If you are interested in certain part of the video but don't want to chop the original video file,
you can simply add the interested part to 'Favorites' and play back only this part later. Your
original video will remain unchanged no matter how many favorites created.
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STEP1
To start, just play the original
video file as normal. Fast
forward video to the
beginning of interested part
and then click 'Mark in'
button.

Current video screen will be
captured and shown as 'IN'
frame.

STEP 2
Play or fast forward the video
to the end of interested part
and click 'Mark out' button.

Current video screen will be
captured and shown as 'OUT'
frame.

DONE
Click 'Add To Favorites'
button. A new item will be
appended to 'Favorites' with
start and end frame preview
and length of media.

When you play this item,
XmediaStorm will start from
the point you mark in and
stop at the point you mark

out. If you click 'Loop' 
button, the same part will be
repeatedly played until you
stop it.

5.3.6 Importing existing video files

Start XmediaStorm in video mode and click button  .
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START
Copy
video
files to
system
video
folder:
Copy all
video
files from
source
folder to
XmediaS
torm's
image
folder.
By
default it
should
be
"C:\Progr
am
Files\Xm
ediaStudi
o\Xmedi
aStorm\I
mage".

Copy
and
recompr
ess files:
Copy
and
recompr
ess
video
files
using
user
specified
codec.
For
example,
if you
have
uncompr
essed
AVI to
import,
you can
choose
to import
as
MPEG4.

Don't
copy
files:
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5.4 Working with Picture

5.4.1 Grabbing picture

XmediaStorm is able to grab pictures from digital camera, scanner and video frames. By
default, all pictures will be stored in 'INBOX' first.

To grab picture from video source (video file, camera input, TV tuner)

Click button . Current video frame will be added to picture library
under 'INBOX' category.

To grab picture from scanner or other TWAIN device

If you are capturing from scanner
(a) Make sure the scanner driver has been properly installed.
(b) Turn on scanner and get ready the document to scan

(c) Go to XmediaStorm's picture manager and click button 
(d) The default scanner's driver will be loaded to start scanning

If you are capturing from digital camera
(a) Make sure your digital camera has a compatible TWAIN driver installed.
(b) Connect and turn on digital camera
(c) Click the same scan button and the digital camera's TWAIN driver will be loaded
(d) Follow the instruction on the pop up window to grab pictures.

5.4.2 Editing pictures

You can use XmediaStorm's built-in tools to do some simple editing  on digital photos. All
tools are accessible from the tool panel

Selection Tools
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Rectangular selection. Demonstration:

Lasso selection. Demonstration:

Magic Wand selection. Demonstration:

Touching up tools
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Adding special effects to selected area or whole picture

Change color effect of selected area or whole picture



XmediaStorm User Manual & Tutorial43

Copyright (c) 2002-2004 XmediaStudio

Other Tools

Zoom in/out. Left click to zoom in and right click to zoom out. For
mouse with scrolling wheel, you can scroll down to zoom in or
scroll up to zoom out.

Move picture

Show/Hide picture's alpha channel (if any)

Fit picture to window

Crop selected area

Mirror picture vertically

Mirror picture horizontally

Rotate picture right by 90 degrees

Rotate picture left by 90 degrees

Rotate picture to specified angle

Undo last change

5.4.3 Making Slide Show

Select pictures for slides by ticking the check boxes. If you don't select any picture, XmediaStorm will
use all pictures under current category for slide show.

Select a transition effect, set the interval and click 'Slide Show' button to start. If you choose "Random',
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then XmediaStorm will display pictures with random effects.

If you prefer a full screen slide show, click on the picture and press key "F11".

5.4.4 Importing existing pictures

To import existing pictures from digital camera, local hard disk and network drive
To import from local hard disk or network drive, skip STEP1.

STEP1:
Connect digital camera to computer or, take out the camera's storage card (Compact Flash,
Secure Digital card etc...) and insert into computer's card reader. Open File Explorer in
windows and check whether a 'Removable Drive' has appeared in the folder tree list. If not,
please check whether the camera has been properly connected and turned on.

STEP2:

Start XmediaStorm in picture mode and click picture import button . The image import
wizard will pop up as shown below:



XmediaStorm User Manual & Tutorial45

Copyright (c) 2002-2004 XmediaStudio

IMAGE
IMPORT
WIZARD

Copy
pictures to
system
image
folder:
Copy all
pictures
from source
folder to
XmediaStor
m's image
folder. By
default it
should be
"C:\Program
Files\Xmedi
aStudio\Xm
ediaStorm\I
mage".

Copy and
resize:
Copy,
resize and
convert
pictures
formats

Generate a
record of
files's detail
and location
only:
Instead of
physically
copying
pictures, a
database
record will
be created
to take
down
source
pictures
size,
dimension,
location,
date&time
and other
details.

To
continue,
click 'Next'
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5.5 Sending video and picture

5.5.1 Preparing video or picture to send

STEP1: Select items from picture or video library by ticking the check box on top right corner.

STEP2: Click button  to call out "Sender". From "Sender" screen, select a sending option to use.

STEP3: Add emails(if send by email) or FTP servers(if upload to FTP server) to the list below:

Adding Emails:
Input destination email address, remarks and click button 'Add'. below is a sample screen:

You also need to setup the SMTP server at main program's setup page. Below is a sample screen:
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Adding FTP servers:
Input server name or IP address, remote directory to upload to, user name, password and then click
'Add'. Below is a sample screen:

5.5.2 Sending through email

STEP1
Select option " Send items to selected email address(es) as attachments":

STEP2
Select emails from list by ticking the check box:

STEP3
Prepare your email template:

DONE
Click 'SEND' button to start sending. The sending progress will be displayed on screen:
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5.5.3 Uploading through FTP

STEP1
Select option "Upload items to selected FTP server(s)".

STEP2
Select FTP servers from list.

STEP3
Click 'SEND' button to start. The progress will be displayed on the screen.

5.5.4 Email Links (URL)

This is a option provided for users who has a website. Instead of sending picture&video as email
attachment, you can send only the "links" by email. So your friends can view your picture by clicking the
URL. To make use of this function, both email list, email template and FTP list need to be setup
properly. Also, you need to define a template for the URL link.

URL Link template
Unless you want to give out the FTP server password for user to access, you are strongly
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recommended to email http links instead of ftp links.

What's the difference
To access your files, a FTP link need to embed the user name and password. For example, if you
uploaded "movie.mpg" to ftp.server.com under "My files" directory and your user name is "user" and
password is "Pass", the FTP link generated by XmediaStorm will be:

ftp://user:pass@ftp.server.com/MyFiles/movie.mpg

However, if you use http link, it will be:

http://www.server.com/MyFiles/movie.mpg

How to start
STEP1: Tick the FTP server to use from server list.
STEP2: Tick the emails to send from email list.
STEP3: Tick the option "Upload items to selected FTP server(s) and email the file links."
STEP: Click button 'SEND'.

5.6 Using Dual Display

To make use of XmediaStorm's dual display function, you need a laptop with external VGA
output or, a desktop with dual head display card installed. The benefit of using dual display is
that you can have one monitor display the control panel and scripts while the other display
the full window video or picture. It is ideal for presentation.

How to setup
To setup, right click on windows desktop and select 'Properties' on pop up menu.
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A 'Display Properties' window will pop up as shown below. Enable display number 2 by
checking the box 'Extend my Windows desktop onto this monitor'. Connect another monitor
to your second output (desktop) or VGA output (laptop) and you should be able to see the
background of the windows desktop.

Start XmediaStorm and go to menu "View->Dual monitor output

Once the frameless picture displayed on the second monitor, your configuration is done. If
you want XmediaStorm to 'remember' this setting, please go to setup page to change and
save the settings.



XmediaStorm User Manual & Tutorial51

Copyright (c) 2002-2004 XmediaStudio

5.7 Organizing Categories

Categories are used to simplify the management of video and picture. There are four default
categories automatically created by XmediaStorm, namely 'ALL CATEGORIES', 'GENERAL',
'INBOX' and 'RECYCLE BIN'. You cannot modify, delete or move those system categories.
However, you can create unlimited number of sub-categories under 'ALL CATEGORIES'.

Creating a new category

To create a new category:

(a) Choose a parent category.
For example, click on 'ALL
CATEGORIES' to make it
parent category for new
category.

(b) Key in new category name

(c) Click button 'Add'

Renaming a category
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To rename a category:

(a) Click to focus on the
category to be renamed

(b) Key in a new name

(c) Click button 'Rename'

The category will be renamed
and all items under this
category will be updated also.

Deleting a category

To delete a category:

(a) Click to focus on the
category to be deleted

(b) Click button 'Remove'

*If you delete a non-empty
category, all items and sub-
categories under this category
will be moved to 'RECYCLE
BIN'.

5.8 Execute third party applications

Executing third party applications within XmediaStorm can be done using right mouse button. To start,
left click on any item to focus on it. A focused item can be identified by the green side bar at right. Then
right click on the focused item and a menu will pop up as shown below:
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Menu Items

Shell Open: Open current item using associated program. For example, if you execute 'Shell Open' on
a BMP file, your favorite picture viewer will be launched to view the picture.

Shell Edit: Edit current item using associated program. For example, if you execute 'Shell Edit' on a
JPG file, PhotoShop will be launched to edit the picture.

Explore Source Folder: Launch file explorer to open the folder containing the selected item.

Copy To: Copy selected item to user specified folder

Print: Use associated program to print current picture. - 'Print' will be disabled if the item selected is
video.

5.9 Moving items between categories

All library items can be moved from one category to another using 'drag and drop' method. By clicking
and holding mouse left button on selected item, you can drag and drop them to another category in the
category list. Here is how to do it:

STEP 1:
Select items to move by ticking the check box.

STEP 2:
Click and hold down left mouse button on the preview picture. Move the mouse and the cursor will turn

to .
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STEP 3:
Move mouse cursor onto the destination category (ROM - 0326) and release the left button. All
selected items under 'Personal Collection' will then be moved to category 'ROM-0326'.
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